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eWallet Overview


Welcome to eWallet!

Welcome to Ilium Software’s eWallet® — the award-winning way to safely
and conveniently store important, confidential information on your
Mac, Windows PC, Android phone or tablet, iPhone, and iPad.

This document contains documentation for many of the features and
functions of Ilium Software’s eWallet for macOS (iMac, MacBook Air, or MacBook Pro).

You can also find step-by-step instructions for using many of
eWallet’s features in the online eWallet Tutorials. You can
open the eWallet Tutorials by clicking the
eWallet Help Center from eWallet’s Help menu.

Thank you for choosing eWallet.




Supported Platforms

eWallet is available on several platforms. They include Android phone and tablets, iPhone & iPad, macOS, and Windows. Please see the main eWallet web page for a list of platforms and
system requirements.




How to Use this Document

You can either read through this document, or use it as a reference by
looking up the particular features that you want in the Table of
Contents or Index. The section Getting Started with eWallet,
contains basic instructions for using eWallet.

Using eWallet contains detailed information about all of the
features and functions of eWallet.

If you’d like step-by-step instructions for using many of
eWallet’s primary features, check out the online eWallet
Tutorials.

Ilium Software, the makers of eWallet, are committed to providing
both high-quality software and excellent technical support.







            

          

      

      

    

  

    
      
          
            
  
Getting Started with eWallet

Ilium Software’s eWallet® is an electronic wallet for your most
important personal information (credit cards, calling cards, passwords,
PINs, account numbers and more). Like a real wallet, eWallet keeps
your information in cards. You can have several related pieces of
information on a card. For example, on a password card, you might have a
username, a password and a URL. You can also personalize cards with
icons, colors, and pictures.

To help keep your cards organized, the cards you create are stored in
categories. Wallet files can have many different categories, and you
can put any kind of card in any category. In addition, you can nest
categories, allowing you to place categories within categories. Like you
do with files in folders on your Mac, you can organize your
eWallet cards and categories however makes the most sense to you.

You can have as many different wallets as you want, and keep
different information in each one. For example, you might want to have a
personal wallet for your own cards, but an office wallet that
you share with an assistant or other members of your team. You can place
copies of the same cards in different files as appropriate. For instance,
you might want your business credit card listed in both of your wallet
files for extra convenience.

You should protect your wallet file with a password. With a password
protected wallet you must enter the wallet’s password before you can see
the information on any of the cards in that wallet. We recommend that
you password-protect all of the wallets that you keep important personal
information in.

You can also choose to have a wallet that does not use a password.
Anyone can open a wallet that does not use a password. We strongly
recommend that you set a password for any wallet that contains personal
information.

More detailed information about passwords, wallet files, categories, and
cards is found in the sections below.


Starting eWallet

When you start eWallet for the first time, you’ll be prompted if
you want a sample wallet or not. If you say yes, eWallet asks you
to save the Sample Wallet in the Documents folder, and then opens
it. If you say no, you can browse for an existing
wallet, or create a new one.

When you’re ready to add your own information, you can add new
categories and cards to wallet and organize the information in a way
that fits your needs.




Adding Your Own Cards

Cards in eWallet are just like the cards you carry in your real wallet.
Create cards for each of the important pieces of information you want to
carry with you.

Select the category you would like to add a card to, and then click the
New Card button on the toolbar or in the Edit menu.

When adding a new card, eWallet prompts you to select a type
of card. After that, you can enter the specific information that you
want to appear on the card.

eWallet gives you many options for personalizing your cards. The way
you access these options vary depending on the device you are using.

When creating or editing a card, select the Edit
(pencil) button in the lower right corner of the window to change the information on
your cards. (You can also press the secondary mouse button and select Edit).




Changing and Deleting Cards

You can make changes to an existing card at any time.

[image: list of cards]
Click on the card in the Card List that you wish to edit, and then
select the Edit (pencil) button in the lower right corner of the window.
(You can also press the secondary mouse button and select Edit). To change the
appearance of a card, once in Edit mode, select the Appearance button
[image: appearance button] to change the appearance of the card.

You can also delete cards that you are no longer using.

In the Card List, press the secondary mouse button on the card you want
to delete and select Delete from the context menu.




Adding, Changing and Deleting Categories

It’s just as easy to add, delete and change your eWallet categories
as it is for cards. To add a new category to eWallet:

Click the New Category button on the toolbar.

You might also need to change an existing category, perhaps to give
it a new name or change the icon. You might also want to delete a
category you are no longer using. Editing a category doesn’t change
the card it contains, but deleting a category deletes all the cards in
that category as well.

To change a category, press the secondary mouse button on the category
and select Edit. To delete a category, click on the category in the Card
List and then press the secondary mouse button and select Delete.

[image: changing a category]
You can change the name of a category and the icon associated
with it. Default Card Type lets you select the default card type
selected when you create a new card in that category. You can always
change the card type for the new card, and you’re not required to have
all the same types of cards in a category. This just controls the
default type eWallet selects when you make a new card. You can still
pick any of eWallet’s available card types from the list when
creating a new card, regardless of the default type for the category.




Nested Categories

eWallet allows you to further refine your card organization with
nested categories. Similar to the way folders can contain other folders
on your Mac, categories can contain other categories, or
subcategories. Subcategories allow you to keep similar types of
information in one place (Credit Cards for example) but also organize
them in a way that’s useful to you.

Click on a category in the Card List where you want to create the
subcategory, and then click the New Category button on the
toolbar.
To make an existing category a subcategory on your
Mac, simply drag the category onto another category. The category you
dragged becomes a subcategory of the category it is dropped on.




Protecting Your Information

Anytime you open a password protected wallet, eWallet asks you
for the password. Until the correct password is provided, eWallet
does not display any of the wallet’s contents.

Once opened, your wallet remains unlocked until:


	you close eWallet on your Mac


	you lock the wallet file by selecting the Lock button on your Mac


	eWallet automatically locks your wallet file if you’ve chosen to
have it do so (See below for information about how to do this)





Note

We recommend always locking your wallet file when you’re not actively
using it.



You can also choose to create a wallet without a password. This is
useful for storing non-confidential information that you want easy
access to. For instance, contacts, family pictures, clothing sizes, and
emergency phone numbers are all information you might want to put into a
wallet that does not require a password.

You can change the password for any wallet, or add a new password to an
unprotected wallet by clicking the Security Manager button on the
toolbar, or by selecting Security Manager… from the File menu. When
changing the password for a password protected wallet, eWallet
asks for the original password first.

You can set eWallet to lock automatically from the Security Options
for the wallet by clicking the Security Manager button in the toolbar.
Alternatively, you can select Security Manager… from the File menu. From there, you
can select timeout locking and other security features.
Read more about these options in eWallet Security.




Selecting a Wallet Password

Choose a password for your wallet that’s easy for you to remember but
would be hard for anyone else to guess. It is best (most secure) to
choose a password that is at least twelve characters long and contains
at least one non-alphanumeric character. One convenient way to do this
is to choose two unrelated words and separate them with a dash, asterisk
or other non-alphanumeric. For example, “clock-kitten” would be a
reasonable password.

Optionally, you can set a password hint for your wallet when you set or
change your password. Choose something that reminds you of your
password, but does not give your password away to someone other than
yourself.

Please note that if you forget the password for a password protected
wallet, you cannot access any of the information in
that wallet. Choose your passwords carefully. Also, if you do run into
trouble, remember that passwords are case-sensitive — if your
password is not being accepted, check that your Caps-Lock is not on.
To protect yourself against forgetting your password, you can create
an Emergency Password Reset Key Card,
and store the printed key information in a secure location, such as a
safety deposit box.




Getting Started Summary

At this point, you should know:


	the difference between cards and categories in eWallet


	how to create and change eWallet cards


	how to protect the information in your eWallet files




The rest of this document contains more detail about eWallet’s
features, functions and options available. You can read through them,
just use them for reference, or just read the sections you’re interested
in.

You’re now ready to begin using eWallet with your own information.
You can either decide how you want to organize your information and
create categories first, or just start creating cards and move them into
specific categories using the clipboard later.







            

          

      

      

    

  

    
      
          
            
  
Using eWallet

While using eWallet, keep in mind that some options may be
unavailable or work differently depending on what kind of object (card,
category, etc.) you have selected or are viewing.

Use the secondary mouse button on objects to bring up a
context menu for that object, or hover over an object to bring up a tool
tip describing that item.


eWallet Files

Files are the topmost level of information used by eWallet. In
eWallet, we call files wallets. Just like any other file on a
Mac, wallets are completely separate from one another. You can have
as many wallets as you want, each with different kinds of information.
For example, you might have one wallet for work and one for personal
information. Each wallet has its own password.

On your Mac, files are assigned an extension. This is a three letter
indicator following a period at the end of the filename that tells the
computer what program the file is associated with. eWallet wallet files end
in wlt. Your computer may or may not be configured to display this
extension.

If you ever lose track of your wallet files, doing a Search on your
Mac for:

.wlt

typically finds every wallet on your computer.

Opening Wallets is handled differently on different devices. When
you run eWallet, however, it automatically attempts to open the
last wallet you used. You may never need to open your wallets any other
way.

Double clicking on a wallet file opens a wallet in eWallet. You can
also open wallets by clicking on the File menu and then selecting Open…
from the menu.

You can make changes to your wallet files using copy, delete,
rename, or move files using Finder in the same way that you
change other files on your computer.

You can Create New Wallets to store your information if you like.
Click the File menu and select New from the menu.

Password protected wallets have one password. eWallet prompts
you to select this password when you first create a new wallet. The
password is required to view the contents, or change the password, of a
password protected wallet.

On your Mac you can copy or move cards between eWallet
wallets using your system clipboard (Copy/Paste or Cut/Paste).


See also

eWallet Security

Synchronization






eWallet Categories

In eWallet, you use Categories to organize your information.
Every wallet must have at least one category, and you can have many
different categories in a wallet.

Use categories to organize your cards in a way that makes sense to you.
You can place any kind of card in any category, and as many or as few
cards as you want in a category.

Each category has the following properties:


	Name: the name of the category


	Icon: the icon representing the category


	Default Card Type: this lets you select the initial card type
selected when you create a new card in that category. You can always
choose a different type when you create the card, and you can have
many different types of cards in a single category. This selection just
controls the initial setting for new cards. You can pick any of
eWallet’s available card types.




You can edit the properties for a category at any time. You can also
nest your categories to further organize your information.


See also

eWallet Security






eWallet Cards

eWallet stores your information in cards. Think of cards just like
the cards in a real wallet. Each card can contain several pieces of
related information. For example, a password card might have a username,
a password and a URL. You can also personalize cards. Each card must be
placed in a category, but categories can contain many different types of
cards. Organize your cards in whatever way makes the most sense to you.


[image: eWallet Card View]
eWallet Card view



You can move your cards between categories at any time. You can move
cards between categories using drag and drop. You can also use your
system clipboard (cut / copy / paste) to move cards around. Edit,
delete, rename, cut, or copy cards by selecting the card and then
right-clicking on the card to show the context menu.


Card Types

eWallet provides 31 different card types (also called templates)
for you to choose from when making a new card (listed below).

Each card has fields and labels appropriate for the kind of information
generally kept on that card type. For example, a credit card provides
fields for:


	the card provider


	the card type, number and expiration date


	the name on the card


	your Personal Information Number (PIN)


	the customer service telephone number




But you can always enter any kind of information in any field on any
card and even rename fields to suit your needs.

You’ll notice the Fields area is broken up into two sections: the
Card Face Fields section and the Details Pane Fields section.
The Card Face Fields typically contain the items you would see on the
physical card itself (card number, expiration date, etc.) while the
Details Pane Fields can be used for the additional information that goes
with the card such as a URL, username, and password. You can enter any
additional information you might want in the Notes area of any card.

Each card type has a default icon associated with it, but you can
change the icon if you like.
In the Card List click on
the card whose icon you want to change,
then use the secondary mouse button and select Edit.

The following card types are provided in eWallet:


	Bank Account - Account numbers for your financial accounts


	Calling Card - Telephone calling cards, with access numbers and
PINs


	Car Info - Information found on your vehicle registration, plus
insurance


	Cellular Phone – Store your critical mobile phone information


	Clothes Sizes - For you, and for the people you buy clothes for


	Combination Lock – The combination for any locks or lockers you
may have


	Contact - Names and phone numbers for personal contacts


	Contact Lens Prescription - Prescription information for contact
lenses, in case you need to replace them when away from home


	Credit Card - Credit card numbers and information, including PINs


	Driver’s License – You can also use this card for medical and
other licenses


	Email Account – System URLs, names and passwords for your email
accounts


	Emergency Numbers – Fire, ambulance, police and other emergency
telephone numbers


	General Purpose – 6 card fields and 25 details fields you can
customize


	Health Numbers – Insurance, Hospital, prescription, group
numbers, etc.


	ID Card – National ID Card or other general purpose ID Card


	Insurance Policy - Auto, Life, Home and other policies, with the
number to call for claims


	Internet Settings – System URLs, names and passwords for your ISP
accounts


	Lens Prescription – Prescription information for eyeglasses in
case you need to replace them when away from home


	Library Card – Number and PIN


	Membership Info - Frequent flier (airline) numbers, video
rentals, store discount, non-profits, and more


	Note Card – A card for any unformatted information


	Passport Info – Everything on your passport, very important to
have a copy


	Password – Usernames and passwords you may have on all the
computer systems you use


	Picture Card – On the platforms that support picture cards,
select any picture that fits on your screen, in bmp, jpg, or png
format


	Prescription – Dosage and other information for prescription
drugs


	Serial Number – Your purchases, including serial numbers, model
numbers and purchase date and location information


	Social Security Number – Use this for other identification
numbers too


	Software Serial Number – Registration codes, purchase dates and
other software product information


	Voice Mail Info – All the access numbers, passwords and commands
you need


	Voter Card – Do you remember where to vote from election to
election?


	Web Site – URL and user or password information for any web sites
you log into







Field Options

eWallet gives you the option to change the label or type for any
field in a card. For instance, you might find that a particular card
does not have as many hidden fields as you might like. Or perhaps you
don’t need a URL on the card but you do want an additional phone number
field. By editing the options for a field, you can create exactly the
sort of card you need.

In the Card List click on the card you want to edit, select the Edit
(pencil) button in the lower right corner of the window to display the fields.
(Alternatively, press the
secondary mouse button and select Edit). Use the
Customize Selected Field area to change the field name and field type.

[image: card fields]
When setting a type for a field, you can choose from the following field
types.


	Date - A field formatted for dates.
This field allows
you to enter the information in date format (e.g., mm/dd/yy).


	eMail - A live email link. When clicking on the contents of this
field, eWallet triggers your default email software and
prepare an outgoing email using this address.


	Hidden - A hidden field. Adds a button to the card used to show
or hide the contents of this field.


	Numeric - A field formatted to only accept numbers.





	Phone Number - A live phone number link. On devices that include
a phone, tapping this live link automatically dials the number
listed as the content of this field. On a Mac, if Skype is
installed, selecting this link makes a call using Skype, as long
as the number is formatted internationally, e.g., +17345551212.


	Text - A plain text field. Enter whatever text you like.


	Web Link - A live link to a web site. Tapping on this link will
automatically open a website on your default browser using the
content of this field as the URL.


	AutoPass Password - Tells eWallet to use the contents of this
field for the password when using AutoPass on your Mac.


	AutoPass Username - Tells eWallet to use the contents of this
field for the username when using AutoPass on your Mac.


	AutoPass Web Link - Tells eWallet to open the website listed
in this field and use the fields on this card defined as AutoPass
Username and AutoPass Password to fill in the login fields for that
site.







Card Quick Entry

All the fields in the card can be entered just by typing, but for some fields
there is an icon to the right of the card. This icon allows you to make
a selection from a list, rather than typing. The Quick Entry icons are:


	[image: credit card or account type] – show a list of some common credit cards or accounts (Credit Card Type or Account Type field)


	[image: calendar] – allow selection of a date (Date field)


	[image: username] – show a list of the top used usernames in your wallet (AutoPass Username field)


	[image: password] – quickly generate a password (AutoPass Password or Hidden field)







Card Properties

In addition to the fields (containing data) in your eWallet cards, you
can also control card colors, card icon, and other aspects of
the card’s appearance. If appropriate for the card type and platform,
you can also set whether a card is scrollable, and whether a hidden field
(for example, a PIN) is initially displayed. You can also set whether the icon
displays on the card face itself. Some appearance options are not
available on some platforms.

To change the appearance settings for your cards, go to the Card List,
click on the card whose appearance you want to change,
and put the card in Edit mode. Finally select the Appearance button [image: appearance button].

The appearance settings allow you to set the card’s background
color, color gradients, text color, icon and related settings. Most of
these features are available on most devices.

There are a number of settings you can choose from. If the card has
hidden fields, such as a password, PIN or lock combination, you can
choose:


	whether the field should be hidden when the card is first displayed (Hide)


	showing (Show)


	or displayed in the same state it was when you last displayed the card (Remember)




You can also
select the color for the text and card background, as well as the icon
associated with the card.

You can also choose between Square and Round corners for the
card when it is displayed using Card View. Choose to Show the Icon on
the Card to display the card’s icon on the card itself in Card
View.
Choose List View to present the card in a grid style
format, rather than the traditional card style format.

The option to add a Background Picture to your cards is available for most types of cards on most platforms.
You can use either Bitmap files, PNG files, or JPEG files as a background.
You can choose to Insert the picture
to copy the file into your wallet. Inserted images sync to some,
but not all devices.
If you choose to Remove
a picture, the picture is removed from the card.

Some devices offer a Picture Position button that allows you to choose
how the graphic is positioned on the card. You can choose to Center the
picture or to display it in the Upper Left, Upper Right, Lower Left or
Lower Right corner of the card. You can also choose to Tile the picture
over the entire area of the card. If the card is a Credit Card, on some
devices you can also choose to use the graphic to replace the default
credit card logo (Replace Logo).See Background Graphics for complete information.




File Attachments

On macOS, eWallet allows you to attach files to your cards so that
you can keep important images and documents close at hand. Files you
attach to a card are encrypted and synchronized. You can attach
any type of file to your wallet including documents, pictures, sound
files, and more.

To attach a file to a card, click the Attach button in the Properties drawer.

Attachment files must be extracted to be viewed. To extract an
attached file, click the Attachment button in the
top right corner of
status bar,
then save the attachment to your Mac.
Note that attached files are synchronized as part of your wallet file,
but adding and extracting attachments may not be available on all
platforms.




Background Graphics

On some platforms, you can customize the appearance of your eWallet
cards by adding pictures to the background. eWallet supports
both bitmap, png, and jpeg image types. On iPhone and iPad it
supports images taken with the camera as well as images stored in the
gallery and photo library on the device.

[image: sample bubbles background image]
Inserting a picture, copies the entire picture into your wallet and
it automatically synchronizes the image to eWallet on any other
devices that support background images. If the wallet is moved, copied,
synchronized, or backed up, all inserted pictures are moved, copied,
synchronized, and backed up as well.

Another advantage of inserting pictures is that the pictures are
encrypted along with the rest of the information in your wallets.

You can use picture files in the bmp, jpg, or png format
on macOS. Pictures can be any size, but you may want to size them
appropriately for your card.

For the most options and for compatibility across platforms, make sure your
Card Style is set to Standard. To set the Card Style,
In the Card List click on the card you want to edit, then put the card
in Edit mode and select the Appearance button. Then make sure
the Style selection is set to Standard
rather than Legacy.

Cards with the Standard Card Style are based on a card size of
312 pixels wide by 184 pixels tall. On high resolution devices, card
sizes are likely be larger, and eWallet scales the background
images/pictures appropriately. For images smaller than the card size
(e.g., a logo), eWallet scales the image so it takes up the same
proportion of space across different platforms. For images larger than
the card size, the image can be down scaled to fit within the card.
Once you’ve added an image, you can
indicate if you’d like images larger than the card size to have:


	no scaling


	scale to fit (the image is scaled down so it fits entirely within the card)v


	or scale to fill (the image fills the card but some of the outside of the image may not be visible)




You can get pictures from any source, as long as they’re in the
previously mentioned formats. Many websites have pictures available for
free download.




Icons

eWallet has more than forty built-in icons that you can use to help
identify cards and categories. The icons are displayed in the list of cards
and categories and are optionally displayed in the lower right corner
of your card.

On macOS you can use one of the over three thousand
Emoji (🧭 🚄 ⚓ 😃 🚒)builtin to the system as icons for your cards and categories. Current versions of eWallet
on other platforms show these emoji as well. Each platform (Apple, Android,
Microsoft) has its own styling for emoji.






AutoPass

eWallet for macOS has a feature called AutoPass for cards that
have URLs, usernames and passwords. With AutoPass enabled, eWallet
attempts to fill-in the username and password fields for you when
you launch the web page from the eWallet card. Currently this
feature is available for
Chrome, Firefox and Safari.
If you are using a default browser such as Opera, you may still
be in luck as many browsers are based on the Chromium engine and can use Chrome
extensions.

To disable AutoPass, click the Settings… menu item under
the eWallet menu and then check the Disable AutoPass box.




Shortcuts

Shortcuts allow you to have your card information in more than one
category without having to duplicate the information. To create a
shortcut to a card,
use the secondary mouse button to click on the card
in the card list and select Create Shortcut.
Shortcuts have a special icon [image: shortcut image] in the card list to help identify
them. You can delete shortcuts the same way you would delete a card.
Deleting a shortcut does not delete the card it points to but deleting a
card does automatically delete any of its shortcuts.




Toolbar and Touch Bar

eWallet’s Toolbar at the top of the main window is customizable.
Select Customize Toolbar… from eWallet’s
View menu and you are able to change the icon size, indicate
that you want icons, text, or both, and even reorder the icons in the toolbar.

On compatible Macs, eWallet also supports the Touch Bar above the
keyboard. The Touch Bar includes the common actions that are available in the
toolbar, but allows you to keep your hands on the keyboard. The Touch Bar
is configurable as well by selecting Customize Touch Bar…
from the View menu. Like with the toolbar, you are able to
reorder the icons in the Touch Bar to your preference.


[image: Main eWallet Touch Bar]





Exiting eWallet

On Mac you can close eWallet in the same fashion that you close many
other applications on your Mac: by pressing Command-Q when eWallet
is the frontmost application.




Application Settings

Click the Settings… menu item under the eWallet menu to get to
application settings. Sync settings are under the Sync
Manager. (Note that in older versions of macOS, Settings were referred to as Preferences.)

[image: eWallet Settings, General tab]
These settings typically apply across wallets.

Under the General tab:


	AutoPass — See the section on AutoPass.


	Show launch window when no wallet is open — the launch window is a convenience if your
wallet(s) are locked/closed; it shows your recently used list of wallets and has buttons for common tasks.


	Clear Pasteboard on close — Any information on the general pasteboard/clipboard is cleared when the
wallet is closed.


	Disable crash reporting — eWallet can report a problem found (anonymously) to a crash reporting service.


	Use Skype for phone links — When activated, clicking on a phone number in a card calls that number using
Skype.


	Use Classic Icons — This option can be used if looking for matching icons with an older mobile version of
eWallet.


	Prefer tabs for multiple wallets — Selecting this option has multiple wallets show up as tabs within
a single window, rather than using multiple windows.




[image: eWallet Settings, Backups tab]
Under the Backups tab:


	automatic backup — eWallet makes internal
backups at certain points. This feature is a
convenience though and not meant to replace doing a real backup of your important files.
You can disable this feature as well as set the number of copies made.







Updates

On Mac, if you purchased a license for eWallet for macOS from Apple using their Mac App
Store, the store itself notifies you of updates and should allow
you to download new versions. This Apple provided feature does require
that you are using the same Apple ID as with the original purchase.







            

          

      

      

    

  

    
      
          
            
  
eWallet Security

eWallet protects your wallet information in 2 ways:


	by requiring a password before displaying any cards in a password
protected wallet


	by encrypting (making unintelligible) the information in cards in
password protected wallets in your wallet file. This means that the
information in the file is translated into a secret code so that it
can’t be read by any other program.




You can set eWallet files to either require a password or not
require a password. Read Protecting Your Information for
more information about how passwords work.

For quick access, you can create a wallet that does not require a
password, but information in that wallet is accessible to anyone who
opens the wallet.


Note

We recommend using wallets without passwords only for general,
non-confidential information.



eWallet uses the Advanced Encryption
Standard (AES) encryption algorithm, with a 256-bit key to encrypt the
data in your cards in password-protected wallets. AES is considered one
of the very best encryption algorithms.

FIPS Certification

Ilium Software’s eWallet 8.13.3 is FIPS compliant on the
Apple platforms where it uses Apple cryptographic libraries that
have received certificates and have been validated as conforming to the
Advanced Encryption Standard (AES) Algorithm, as specified in Federal
Information Processing Standard Publication 197, Advanced Encryption
Standard. Please see the Advanced Encryption Standard Algorithm
Validation
List
for more information.

You can explicitly lock your wallet at any time, by choosing the
Lock button on eWallet’s toolbar.

A password is required to open any password protected wallet.
eWallet prompts you for a password when you first open a
password protected wallet. After entering the correct password, you may
use all of the wallet’s features until it is locked again.


Security Options

You can increase the security of eWallet using the available
security options. Click the Security Manager button in the toolbar, or
by selecting Security Manager… from the File menu.


[image: Wallet Security Settings]
Wallet Security Settings



The security options include:


	Having eWallet close and lock your wallet after a specified
amount of time if it doesn’t get any user input. Whether the
wallet is active or minimized, the wallet automatically locks.
Once the wallet is closed and locked, the password is required to
access the wallet again. Choosing this option helps prevent
someone from being able to see your information if you’ve
unintentionally left your wallet open.


	Having eWallet lock out wallet access if a specified number of
incorrect password attempts are made. Once the wallet’s access is
locked, no attempts to open the wallet are allowed for a specified
period of time. You can choose how many incorrect password attempts
are allowed before the wallet’s access is locked, and how
long the wallet’s access stays locked once the limit has been
reached. This makes it more difficult for someone to try to break
into your wallet by guessing several passwords or using a piece of
software that automatically enters passwords. However, this also
makes it more difficult for you to try multiple passwords if you
misplace or forget yours, so use this option with care.




You can change the password or add a new password for any wallet. When
changing the password for a password protected wallet, eWallet
asks for the original password first. Click the Security Manager button
on the toolbar, or by selecting Security Manager… from the File menu to
change a password.

Choose a wallet password that’s easy for you to remember, but would
be hard for anyone else to guess. It is best to choose a password that
is at least fourteen characters long and contains at least one
non-alphanumeric character. One convenient way to do this is to choose
two or three unrelated words and separate them with a dash, asterisk or other
non-alphanumeric. For example, “clocK-47kittEn” might be a reasonable
password. Please note that if you forget a password, you cannot
access the information in your wallet file. Choose your
passwords carefully. Remember that passwords are case-sensitive — if
your password is not being accepted, check that your Caps-Lock is not
on.


See also

Protecting Your Information






Emergency Password Reset Key

The Emergency Password Reset Key is a set of information that can be used
to reset a wallet’s password when the wallet’s current password is not known.
This information is intended to be printed or written down on paper so it
is available for use when it is needed. The purpose of this information
is to help users who have forgotten the password to their wallet to gain
access to their passwords again. It can also be useful when a user is
incapacitated or deceased and their survivors need to access the passwords
or other key information in the wallet to help settle the estate.

The Emergency Password Reset Key Card is a card in the wallet that has been
generated by eWallet and contains the Emergency Password Reset Key information.
The card can be printed anytime to provide a paper copy of the information.
The card must remain in the wallet in order for an Emergency Password
Reset to be performed.

To configure your wallet for the Emergency Password Reset Key Card on
eWallet for macOS, click the Security Manager button on
the toolbar, or by selecting Security Manager… from the
File menu. Once the Security Manager is open,
click the Manage Password Reset button to get started.


Important

Do not delete this card

The Emergency Password Reset Key Card must be present in the wallet in
order for a password reset to be performed. If you delete the card you
won’t be able to do a password reset.



For more information, please see the
Emergency Password Reset Key support
article on our website.




Touch ID

On compatible hardware with macOS Catalina or later, eWallet for
Mac supports Touch ID as an additional method for unlocking a wallet.
If you like to activate Touch ID for your wallet, use the
Security Manager to configure this feature.


Note

Remember your password


	Using Touch ID is a convenience but is not a permanent substitute for knowing
your wallet password


	There are several ways that Touch ID can be turned off, so it’s really important
that you remember the password to your wallet






To use Touch ID to unlock your wallet, when prompted, place your finger on the Mac’s
Touch ID sensor. On Mac’s with a Touch Bar, there is a prompt similar to:

[image: Unlock wallet using Touch ID]






            

          

      

      

    

  

    
      
          
            
  
PassBuilder

PassBuilder™ allows you to generate a password within eWallet.


Using PassBuilder


	Edit a card and select the field where you would like to store the
password and click Generate Password
toward the bottom of the Edit panel.


	You are presented with the PassBuilder window which allows
you to choose several options.


	Pressing Generate Password builds a password to your
specification.


	You can then press Insert Password and Close to copy your new
password into your wallet card, replacing any previous value in the
field.





Instant Passwords

Clicking the Instant Password button [image: generate password button] next to a hidden field
instantly creates and inserts a password for you without you having
to go to the separate Generate Password panel. The passwords are built
using your settings from the previous time you generated a password. To have more control over
generating a password, press the Generate Password button instead.






PassBuilder Options

[image: password builder options]

Password Length

The length of the generated password can be up to 100 characters.




Allowed Characters


	Lowercase Letters (a-z) — The password can include lowercase
English characters.


	Uppercase Letters (A-Z) — The password can include uppercase
English characters.


	Numbers (0-9) — The password can include numbers (digits). In
addition, selecting this option ensures that at least one
character in the generated password is a number.


	Punctuation — The password can include any of the punctuation
characters included in this field. PassBuilder defaults to including:

! @ # $ ^ & * ( ) - =

but you can change the field to anything you like.








Memory Aid


	None — With the Memory Aid set to None (the recommended setting),
PassBuilder generates random passwords from the selected Allowed Characters
groups with the length you indicate.


	If you find particular characters hard to distinguish (e.g., the number one from
a lowercase L), then you can exclude those characters from the pool of Allowed Characters


	If your password length is at least 8, then PassBuilder generates a random password
that has at least one character from each of the selected Allowed Characters groups









Tip

If you absolutely must memorize a password or two, then the Mnemonic Sentence,
Pronounceable, Dictionary, or Dictionary – Warped Memory Aids may be helpful to you.




	Mnemonic Sentence — With this option, PassBuilder also
generates a sentence that could help you to remember the password. For
example, if PassBuilder generates the password Bni, it would show
you the mnemonic sentence was Brian nibbled icons. Any Numbers
or Punctuation are added to the end of the sentence.

When selecting this option, you are also presented with two
additional buttons. The Copy Memory Aid to Clipboard button copies
the mnemonic sentence to the clipboard for your use in other software
The Append Memory Aid to Card Note button adds the mnemonic
sentence to the end of your card notes.



	Pronounceable — The Pronounceable option is based on the U.S.
governments FIPS 181 specification for creating pronounceable
passwords. The key advantage is that a Pronunciation Aid is
displayed that uses syllables to help you remember your password. Any
Numbers or Punctuation is prepended and/or appended to
the password.


	Dictionary — The Dictionary option starts with a word from a
built-in dictionary. Additional characters are then mixed into the
password to fill it out to the requested Length. If the
Warped option is selected, certain characters are changed so
the password is still readable, but it would be harder for someone to
guess. For example, an a might be changed to an @ and a s
might be changed to a 5 or a z.




[image: password builder options, warped]








            

          

      

      

    

  

    
      
          
            
  
Synchronization

Synchronization is the process of keeping wallets that are stored in
multiple locations updated with the same information. This way, for
example, if you
make a change on your mobile device, the next time you view
the same wallet on another device or computer, your change is there.

With SyncPro Synchronization, you can make simultaneous changes to
different cards on your Mac, remote location,
USB drive, or a mobile device and all the changes are synchronized.
SyncPro goes through all the cards and matches the changes between the
locations. Even if you’ve made changes in three different locations (on
your Mac, iPhone, and an Android device for instance) SyncPro goes
through and combines all those changes.

eWallet 8.13.3 for macOS synchronizes your information with a
built-in sync engine called SyncPro® and offers three different kinds of
sync: Cloud sync, Device Sync, and Folder sync. SyncPro’s cloud sync on
macOS allows backing up to a cloud service (currently Dropbox, Google Drive,
Microsoft OneDrive, or iCloud). You can
use the cloud service to sync with eWallet on other devices and computers.
Device Sync offers a syncing method that occurs
directly between two devices using a local Wi-Fi network. SyncPro also
offers synchronization to a folder, which can be very handy in an office
environment where you may want to share one or more wallet files.

eWallet’s Sync Manager helps configure the kind of sync you
want for your wallet. Once it’s configured, you just press the Sync Now
button to synchronize your wallet. Some of the sync types can also
happen automatically when eWallet opens and closes.

[image: Sync Manager]
SyncPro synchronization is setup, run, and managed in the macOS version of
eWallet. Click the Sync Setup button on the toolbar or select Sync
Manager… from the Synchronize menu to change synchronization settings
for your open wallet file. To change settings for another wallet file,
first open the file, and then use the same options.


SyncPro Synchronization

With SyncPro synchronization, you can make simultaneous changes to
different cards on your Mac:


	an Android phone or tablet


	an iPhone or iPad


	other computers/disks on a network


	or any other storage device attached to your computer and all changes are synchronized





Synchronization Setup

To setup synchronization for the cloud, an Android device, iPad, iPhone,
different computer, or external storage device, open the Sync
Manager window by clicking the Sync Manger button on the toolbar. Alternatively
select Sync Manager… from the Synchronize menu. The
following areas and buttons are in the Synchronization Setup display.

[image: sync setup]

	Sync Location: These are devices that are ready to synchronize
with eWallet. They may or may not be set to synchronize with the
particular wallet you have open. If eWallet does not
automatically display the device you would like to synchronize with,
you can click the Add button to add a new “location” (device/service/folder,
etc.) to this list. For Android, iPad, and iPhone the name
displayed by default is the device name.


	Add: This button allows you to add additional locations (devices,
services, etc.) that you would like to synchronize wallets to. For
more information on this, see Adding Sync Locations.


	Edit: This button allows you to edit the details for a Sync
Location on the list or change the Sync direction (the direction
eWallet sends data when you sync).


	Remove: This button removes a Sync Location from the list. If you
remove a location, you can always add it to the list again using the
Add button.


	Download: The Download button allows downloading a copy of a wallet
from a remote location, such as a mobile device or a cloud service. This
is useful if you don’t already have a local copy of the wallet on your
Mac.










	Synchronization
Directions

	When to use





	Wallet
Synchronizes
with Sync
Location

	You often change data both on the Mac and in
the wallet stored at the Sync Location.



	Wallet
overwrites Sync
Location

	You only make changes on the Mac and never make
changes directly to the wallet stored at the Sync
Location. This is useful if you wish to save a
backup to a different folder on your Mac or a
remote sync location.



	Sync Location
overwrites
Wallet

	You only make changes to the wallet stored at the
Sync Location and never make changes to the wallet
on your Mac. You might choose this to
synchronize a company wallet on a server to the
Mac you are using.



	None

	No synchronization occurs.






To run synchronization either click on the Sync Now button on the
toolbar or select Sync Now from the Synchronize menu.

Remember that your eWallet passwords need to be the same on any
wallets (cloud or otherwise) that sync with each other.




Change the Sync Direction

There are times when you may want to change the direction eWallet is
synchronizing. That is to say, you may want to only transfer the
information in one direction or the other, rather than truly
synchronizing the wallets. To change the direction your information is
synching, follow the steps below.


	Open eWallet on your Mac and click the Sync Manager button on the
toolbar or select Sync Manager… from the Synchronize menu.


	Select the location you want to change and press the Edit button.


	Select the way you would like your information to synchronize from
the context menu that comes up.









Adding Sync Locations

You can setup eWallet to synchronize with additional devices,
services and locations using the Add button. eWallet can synchronize
with:


	the cloud


	Android devices


	iPhones and iPads


	USB drives


	computers/disks on a network




You can even set
eWallet to synchronize a wallet to a different folder on the same
computer as a means of making a regular backup of your data.

To add a new Sync Location do the following:


	Open the Sync Manager dialog by selecting the Sync Manager button on
the toolbar or by selecting Sync Manager… from the Synchronize menu.


	Click the Add button.


	Click the button for the type of location you would like to add.


	Follow the instructions on the screen for adding a location of that
type. Note that for some locations, such as Android, iPhone, and iPad,
you may need to perform additional steps on the device to add
it as a new location.




At the end of the setup process, eWallet may ask if you would like
to synchronize. You can synchronize immediately or click No and
synchronize later. Whenever you synchronize your wallets in the future,
the wallet is synchronized to the new location as well.

If you’ve made a mistake when entering the path or address for another
computer or a remote location, you can correct it. Simply select the Sync
Location and then click the Edit button.

To synchronize with a remote location or another computer, you must use
the proper formatting.


	Networked Computer/disk: /<Volumes>/<Name>/<directory1>
Example (/Volumes/Server/wallets)


	Removable Drive (Ex: USB): /<Volumes>/<USB Name>/<directory1>
Example (/Volumes/USB1/wallets)


	Local Folder: /<directory1>/<directory2> (Example:
~/Documents/Wallets)





Hints & Tips


	You can only synchronize the data if you have write access to both
locations. Otherwise, you likely want to choose one of the Overwrite
sync directions.


	Create a central wallet for multiple users by placing the master
wallet in a read-only folder on the network and having each user
synchronize with Sync Location overwrites Wallet.


	Synchronize data to a folder on the same Mac (or even better,
another Mac or PC) is a way to easily make a backup of your
information. Cloud Sync is another method of
keeping a backup.


	Combine two wallets on the same Mac by giving them the same name
and password, synching them to one another one time, and then
removing the Sync Location.









Cloud Sync

eWallet’s SyncPro engine on macOS has a cloud sync option. With
cloud sync there is no need for a direct connection between Macs to
sync. And of course you can also use cloud sync as one method of
creating backup files of your wallet and get it stored safely off-Mac
and off-site.
With eWallet for macOS you have the option of using
either Dropbox, Google Drive, Microsoft OneDrive, or iCloud services.

With any of the cloud services, there is no need to install any client software for that service. For example, there is no need to install the Dropbox, Google Drive, or Microsoft OneDrive app.

[image: cloud sync]
Using the Cloud Sync option, the cloud version of your wallet
can be considered the master
version that can be used to keep devices with this feature up-to-date.
(Note that the cloud wallet file has the .cwlt extension when used with Dropbox, Google Drive, or Microsoft OneDrive.)
Once you’ve configured your wallet to sync with the cloud, sync can
pretty much happen automatically. There are two ways to do the initial
setup: start with a cloud wallet or start with your local wallet (as
outlined below).


Configuring Sync

[image: cloud sync, choose cloud provider]

	Start eWallet and if you have a copy of the wallet on your Mac already, open it


	Start the Sync Manager from the toolbar area
or by selecting Sync Manager… from the Synchronize menu


	If your Dropbox, Google Drive, OneDrive, or iCloud account
is not listed as one of the Sync Locations:


	Press Add


	Select Cloud Sync


	Select the Dropbox, Google Drive, OneDrive, or iCloud button


	If necessary, enter any appropriate credentials and
allow access to Dropbox, Google Drive, or Microsoft OneDrive; otherwise select your Sync Location and
press Next


	If you have a copy of the wallet on your Mac opened already and want to sync with it, choose the Select the open wallet option button and press Next –or–


	If you’d like to start with a wallet in the cloud, select Choose a wallet that is on [cloud service], select the cloud wallet, then pick the local folder to save your local copy of the wallet to and press Choose






	Press Close in the Setup Complete panel and then Close in the Sync
Manager panel






	If your Dropbox, Google Drive, OneDrive, or iCloud account
is already listed as one of the Sync Locations (i.e., previously configured):


	Select the Dropbox, Google Drive, OneDrive, or iCloud Sync Location
(the sync direction is likely “None” at this point)


	If you want to get a local copy of a wallet that’s only in the cloud, press the Download button; otherwise select Edit and change the Sync Direction to “This wallet synchronizes with…” and press the OK button











Sync with Cloud Wallet

You should now be good to go! You can always sync your wallet by
pressing the Sync Now button at the top of eWallet. By default,
eWallet automatically syncs with your cloud wallet when you
start eWallet and when you close it. The automatic syncing can be
changed in the SyncPro Options panel, available from the Sync
Manager.

[image: SyncPro options]





Device Sync - Android

eWallet for macOS offers full synchronization with your Android device using a
local wireless network. Use SyncPro to quickly and easily synchronize as
many wallets as you like directly with your mobile device. A more
automatic alternative to this direct method is covered in
Cloud Sync.

The simplest way to set up synchronization with your Android device is
to start eWallet on your device and then press the Sync [image: local Wi-Fi sync button] button.
eWallet on the Android device walks
you through the entire process. The instructions below provide detailed
information about the various steps in that process.


Android Wireless Sync Basics

The following is basic information and frequently asked questions that
may help troubleshoot any problems you are having with synchronizing
with your Android device.


Wireless Networks

In order to synchronize eWallet on your Mac with
eWallet on your Android device, both devices need
to be connected to the same wireless network. The Mac that
you are using may be connected directly to the network (not
wirelessly) but the Android device must connect wirelessly to use
Wi-Fi sync.




Ad hoc Wireless Networks

It is possible to synchronize your Android device to your Mac
using an Ad hoc Wireless Network. Ad hoc Wireless Networks are temporary
networks that allow two computers to communicate. For more information
on creating an Ad hoc Wireless Network, see the
Apple documentation
on your Mac.




Public Wireless Networks

Although it is always safest to synchronize using a personal or Ad hoc
Wireless Network, it is possible to synchronize using some public
networks. It is possible, however, that when synchronizing over a public
network that someone might attempt to intercept files being transferred,
including your wallet. As a result we strongly recommend that you do not
synchronize on public wireless networks.




Creating a Partnership

For your security, eWallet requires that you create a partnership
with your Android device within the eWallet program on the
Mac. This ensures that when you synchronize, your wallet is always
synchronizing with the exact same computer you expect it to. If you wish to
synchronize eWallet on your Android device with eWallet
on other computers as well, you need to create partnerships with
eWallet on those computers as well. When you set up sync
eWallet walks you through this process, or you can refer to the
instructions for creating partnerships below.




Synchronizing

In order to create a partnership or synchronize with your Android device, you
must activate sync on both your Mac and Android device. To activate
sync on your Android device, simply press the Sync [image: local Wi-Fi sync button]
button in eWallet on the device. To activate sync on the Mac,
click the Sync Now button in the toolbar.






Create a Partnership

Before you can synchronize eWallet for macOS on the Mac with eWallet on
your Android device, you must first create a partnership between the two
devices in eWallet. This is a security measure than ensures that
whenever you sync, your wallet is always synchronizing with the computer
you think it is.

Follow the one-time steps shown below to create a new partnership in eWallet
between your Mac and your Android device.


	On your Android device, start eWallet, press the Sync [image: local Wi-Fi sync button] button,
then tap Sync Setup and follow the instructions on the screen (which are also outlined below).


	Open eWallet on your Mac with the wallet you want to sync
with and click the
Sync Manager on toolbar.





	In the Sync Manager window, click on the Add button (skip this
step and go to Step 4 if you haven’t created any other partnerships yet).


	Choose the Device Sync button, then click on the Android button.
(You may be asked to enter the IP address from your device — you can find it
at the bottom of the synchronization screen displayed on
your device).


	At the Setup sync for Android window, select your device from the list
provided and click OK.


	At the Enter Authorization Code window, enter the five digit
authorization code that now appears on your Android device, then
click Submit.





Note

If you don’t have the wallet you want on your Mac (say
you started with Android and the wallet is only on that device),
then you can pick a wallet from the list of wallets pulled from
your device.

If you happen to have a different wallet open on your Mac
and still want to sync with a wallet that’s only on your Android device,
then select “Choose a wallet that is on the device” when prompted.

If you’ve previously configured a Sync Location, you can select it and then
press the Download button to see wallets on your Android device.
Just make sure the Android device is already in Sync Mode when you do this.




	When asked by eWallet for macOS if you want to Synchronize,
click Yes.


	You may see a message indicating the wallet does not exist on the Android side,
or the Mac side and see a question like, “Would you like eWallet to create it?”
In this case, click Yes.







Synchronize Your Wallet

Once you’ve created a partnership between your Android device and your
Mac, you can synchronize your wallet whenever you need to. The key to
synchronizing is that you must start sync on both your Mac and your
Android device. Follow the steps below to synchronize your wallets.


	On your Android device, start eWallet, press the Sync [image: local Wi-Fi sync button] button,
then press Synchronize.


	Open eWallet on your Mac and click the Sync Now button on the
toolbar.




Once you’ve completed these steps, eWallet does the rest. If you
are synchronizing more than one wallet you may be prompted on the Mac
side about whether you want to sync a selection of the wallets.






Device Sync - iPhone & iPad

eWallet for macOS offers full synchronization directly with your iPhone
and iPad devices using a local wireless network. Use
SyncPro to quickly and easily synchronize as many wallets as you like
with your mobile device. A more automatic alternative to this direct
method is covered in Cloud Sync.

The simplest way to set up synchronization with your iPhone or iPad is to
start eWallet on your device and then press the Sync
[image: local Wi-Fi sync button] button. eWallet on the device walks you through
the entire process. The instructions below provide detailed information
about the various steps in that process.


iPhone & iPad Sync Basics

The following is basic information and frequently asked questions that
may help troubleshoot any problems you are having with synchronizing
with your iPhone or iPad.


Wireless Networks

In order to synchronize eWallet on your Mac with
eWallet on your iPhone or iPad, both devices need
to be connected to the same wireless network. The Mac that
you are using may be connected directly to the network (not
wirelessly) but the iPhone or iPad must connect wirelessly to use
Wi-Fi sync.




Ad hoc Wireless Networks

It is possible to synchronize your iPhone or iPad to your Mac
using an Ad hoc Wireless Network. Ad hoc Wireless Networks are temporary
networks that allow two computers to communicate. For more information
on creating an Ad hoc Wireless Network, see the
Apple documentation
on your Mac.




Public Wireless Networks

Although it is always safest to synchronize using a personal or Ad hoc
Wireless Network, it is possible to synchronize using some public
networks. It is possible, however, that when synchronizing over a public
network that someone might attempt to intercept files being transferred,
including your wallet. As a result we strongly recommend that you do not
synchronize on public wireless networks.




Creating a Partnership

For your security, eWallet for macOS requires that you create a partnership
with your iPhone or iPad within the eWallet program on the
Mac. This ensures that when you synchronize, your wallet is always
synchronizing with the exact same computer you expect it to. If you wish to
synchronize eWallet on your iPhone or iPad with eWallet
on other computers as well, you need to create partnerships with
eWallet on those computers as well. When you set up sync
eWallet walks you through this process, or you can refer to the
instructions for creating partnerships below.




Synchronizing

In order to create a partnership or synchronize with your iPhone or iPad, you
must activate sync on both your Mac and your iPhone/iPad. To activate
sync on your iPhone or iPad, simply press the Sync [image: local Wi-Fi sync button]
button in eWallet on the device. To activate sync on the Mac,
click the Sync Now button in the toolbar.






Create a Partnership

Before you can synchronize eWallet on the Mac with eWallet on
your iPhone or iPad, you must first create a partnership between the two
devices in eWallet. This is a security measure than ensures that
whenever you sync, your wallet is always synchronizing with the computer
you think it is.

Follow the steps shown below to create a new partnership in eWallet
between your Mac and your iPhone or iPad.


	On your iPhone or iPad, start eWallet and then press the
Sync [image: local Wi-Fi sync button] button, then tap Sync Setup
and follow the instructions on the screen (which are also outlined below).


	Open eWallet on your Mac with the wallet you want to sync
with* and click the
Sync Manager on toolbar.





	In the Sync Manager window, click on the Add button (skip this
step and go to Step 4 if you haven’t created any other partnerships yet).


	Choose the Device Sync button, then click on the iPhone/iPad button.
(You may be asked to enter the IP address from your device — you can find it
at the bottom of the synchronization screen displayed on
your device).


	At the Add/Setup sync window, select your device from the list
provided and click OK.


	At the Enter Authorization Code window, enter the five digit
authorization code that now appears on your iPhone or iPad, then
click Submit.





Note

If you don’t have the wallet you want on your Mac (say
you started with your iPhone or iPad and the wallet is only on that device),
then you can pick a wallet from the list of wallets pulled from
your device.

If you happen to have a different wallet open on your Mac
and still want to sync with a wallet that’s only on your iPhone or iPad,
then select “Choose a wallet that is on the device” when prompted.

If you’ve previously configured a Sync Location, you can select it and then
press the Download button to see wallets on your iPhone or iPad.
Just make sure the iPhone or iPad is already in Sync Mode when you do this.




	When asked by eWallet for macOS if you want to Synchronize,
click Yes.


	You may see a message indicating the wallet does not exist on the iPhone/iPad side,
or the Mac side and see a question like, “Would you like eWallet to create it?”
In this case, click Yes.







Synchronize Your Wallet

Once you’ve created a partnership between your iPhone or iPad and your
Mac, you can synchronize your wallet whenever you need to. The key to
synchronizing is that you must start sync on both your Mac and your
iPhone or iPad. Follow the steps below to synchronize your wallets.


	On your iPhone or iPad, start eWallet and then press the
Sync [image: local Wi-Fi sync button] button, then press Synchronize.


	Open eWallet on your Mac and click the Sync Now button on the
toolbar.




Once you’ve completed these steps, eWallet does the rest. If you
are synchronizing more than one wallet you may be prompted on the Mac
side about whether you want to sync a selection of the wallets.






SyncPro Options

You can control when SyncPro synchronization occurs and if you want to
confirm each synchronization. Note that SyncPro checks all your
SyncPro wallets when synchronization occurs but only synchronizes
the wallets that need it.

Synchronization Occurs:







	Cloud sync:

	


	When I start
eWallet

	SyncPro cloud sync is initiated when
eWallet on the Mac starts.



	When I close
eWallet

	SyncPro cloud sync is initiated when
eWallet on the Mac quits.



	Other Sync:

	


	When I start
eWallet

	SyncPro synchronization occurs for (locations
that don’t require interaction) whenever
eWallet on the Mac starts.



	When I close
eWallet

	SyncPro synchronization occurs (locations that
don’t require interaction) when eWallet on
the Mac quits.






Confirmation:







	Always

	Always prompt for confirmation before SyncPro runs.



	Never

	Never prompt for confirmation before SyncPro runs.



	Only when I
have multiple
files
synchronizing

	Select this confirmation option to prompt for
confirmation if you have more than one wallet file
to be synchronized.







Note

If syncing only with the cloud at startup or exit, eWallet skips
confirmation even if the Only when I have multiple files synchronizing
option is selected.









            

          

      

      

    

  

    
      
          
            
  
More eWallet Features

Backups

For extra safety, we encourage you to make backups of your eWallet
files (as well as all of your important information). These backups,
like backups of any of your other important files, should be saved
somewhere offsite on a reliable media.

eWallet also has an automatic backup copies feature makes a
copy of your wallet after you close it. eWallet can keep a number of these
copies around in case you need them. A good example of using this
feature is if you recently deleted a card you didn’t mean to; in that
case you might find the card in the copy. This feature is a convenience
though and not meant to replace doing a real backup as described
earlier. This copy is stored in:

~/Library/Containers/com.iliumsoft.ewallet.mac/Data/Library/Application Support/Ilium Software/eWallet/Wallet Backups

To easily get to this folder to see your backup copies, from the File menu select
Wallet Backups → Open Backups Folder. To change the number of backup
copies made, select Wallet Backups → Backup Settings… from the File menu.

You can also make a backup copy manually. On your Mac, select Save As… from
eWallet’s File menu and choose eWallet File… for the format.

Search

In eWallet on you can use the Search or Find feature to search all
of the cards in a wallet for a particular piece of information. Search
returns results as you type, returning the name of the card as well
as its category.

Smart Copy

You can right-click on a value on your card or in the Details pane and
then use Copy <field name> to copy that value to the clipboard.

When you use the Copy <field name> command on a credit card’s card
number, only the digits are copied to the clipboard. Spaces and
dashes are removed using this copy command to make pasting to forms on
web sites easier.

Recent Cards

Clicking the Recent Cards button [image: recent cards icon]. below the list of cards is a
handy way to show you the list of cards you’ve recently accessed, sorted
with most recent at the top.

Printing

You can print your wallet from your Mac using eWallet’s Print
menu selections in the eWallet File  menu. You can print
your entire wallet or a selection of cards.

Export

You can export your eWallet information to a text file from
eWallet for printing or extra backup by using Save As… and choosing
Text File… for the format. This copies all the information on each card in your
wallet to the file you specify. Please note that exported information is
not secure, and that any colors, graphics, and attached files associated
with a card are not exported. Also, it is not possible to import this
data back into eWallet. See the instructions for Making a Backup for
ways to backup the actual wallet file.





            

          

      

      

    

  

    
      
          
            
  
Credits

eWallet for macOS includes the following embedded software.
Please note licenses and/or copyrights are for the embedded software only and do not apply to
eWallet for macOS itself:

Dropbox cloud library

Copyright (c) 2015-2021 Dropbox Inc., http://www.dropbox.com/

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.





See Dropbox for details.

Down Markdown library

Copyright (c) 2016 Rob Phillips.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.





See Down for details.

Bugsnag exception reporter

Copyright (c) 2012 Bugsnag, https://bugsnag.com/

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software
is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.





See Bugsnag for details.

Inconsolata font

Copyright 2006 The Inconsolata Project Authors (https://github.com/cyrealtype/Inconsolata)

This Font Software is licensed under the SIL Open Font License, Version 1.1.





See Inconsolata for details.





            

          

      

      

    

  

    
      
          
            
  
Customer and Technical Support


How to Contact Ilium Software


	Information and Sales
	For Technical or Customer Support, Sales or general queries, please
visit our web site. If you have a question, the best way to reach us
is via the contact information below.



	Support
	For Technical or Customer Support, visit our
Support area, or reach us
using the contact information below.



	Contact Information
	





	Web:

	Use our secure web server at
www.iliumsoft.com



	Email:

	www.iliumsoft.com/contactus



	Mail:

	
Ilium Software

885 Penniman Ave., #6025

Plymouth, MI 48170 USA













[image: Ilium Software company logo]
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